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Tool Name  Used For  Description  Windows Download  Mac OS Download/Alternative 
Program 

DROID 
 

Checksum (MD5) 
 
File Format Identification 

Generates MD5 checksums. 
 
Performs  batch  identification  of  file  formats,  and  links  to 
central  registry  for  technical  information  (PRONOM). 
Generates reports (PDF), or saves results as .CSV. 
 
Helps  to  understand  your  digital  assets,  assess  risk,  and 
plan  for  action  (migration  to  archival  file  formats,  for 
example). 

z.umn.edu/k68  Mac OS download available 

Exact File 
 

Checksum (MD5, SHA1, 
SHA256, & more) 

Helps maintain file integrity:  Use to make sure files haven’t 
been changed or damaged over time, or in the process of 
moving files from one location to another. 

www.exactfile.com  DROID captures MD5 checksums.   A search 
for MD5, Sha‐1, or Hash in the App Store 
brings up many free and paid options.   

Hash My Files 
 

Checksum (MD5, SHA1, 
CRC32, SHA‐256, & more) 
 
Duplication Detection 

Helps maintain file integrity:  Use to make sure files haven’t 
been changed or damaged over time, or in the process of 
moving files from one location to another. 
 

Saves checksum values as CSV/Tab‐Delimited. 

z.umn.edu/k69  DROID captures MD5 checksums.  A search 
for MD5, Sha‐1, or Hash in the App Store 
brings up many free and paid options.  A 
search for “file duplicates” also returns many 
results.  

Karen’s Directory Printer 
 

Checksum (MD5) 
 
File Format Identification 

Helps maintain file integrity by generating MD5 checksums.   
 

Prints names of every file on a drive, file size, date/time of 
last modification, and file attributes.  Saves information as 
.txt file. 

z.umn.edu/k6a  DROID captures file format information, 
selected file/folder metadata, and can 
capture MD5 checksum values.   

Metadata Quality Control 
(MDQC) 

Metadata Quality Control  Compare expected technical (and some non‐technical) 
metadata to actual technical metadata.  (E.g. run the tool 
on a group of files returned to you from a vendor). 

z.umn.edu/k6b  Mac OS download available 

Duplicate File Finder  Duplication Detection   Find and delete duplicate files.  Can compare content byte 
by byte or match on file name. 

www.ashisoft.com  Alternative Program:  
Araxis Find Duplicate Files: z.umn.edu/k6c 
A search in the App Store for “file duplicates” 
returns both free and paid options.  

Windows Directory Statistics 
(WinDirStat)  

File Visualization  Helps visualize the contents of selected drives and learn 
more about the properties of the content, and allows for 
deletion of content. 

windirstat.info  Alternative Programs:  
Disk Inventory X: www.derlien.com 
 
GrandPerspective: 
grandperspectiv.sourceforge.net 
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DROID Resource Guide 

 

 

Tool Name:  DROID (Digital Record Object IDentification) 

 

Functionality/Use:  The main purpose of DROID is to identify (or confirm) file formats.  During 

this process additional file metadata is captured and recorded in reports.  Checksums can also be 

run and used to find duplicate files.  (Windows and MacOS) 

 

 

To Install: 

(Windows)  

- Download from The National Archives at: 

http://www.nationalarchives.gov.uk/information-management/our-services/dc-file-

profiling-tool.htm  (droid-binary-6.1.3-bin.zip) 

- Unzip the folder (if needed). 

 

 (Mac OS) 

- Download from The National Archives at: 

http://www.nationalarchives.gov.uk/information-management/our-services/dc-file-

profiling-tool.htm  (droid-binary-6.1.3-bin.zip) 

- Unzip the folder (if needed). 

- Move the folder to a location in which you can navigate to easily with the “Terminal”. 

- Set the Executable Permissions 

o Open the Running DROID.txt file for instructions/commands. 

o Open the Terminal 

o Navigate to the folder that contains the droid.sh, droid-command-line-6.1.3-jar, 

and droid-ui-6.1.3.jar files.   

 cd droid-binary-6.1.3-bin   [is all I had to do with the folder directly under 

my home folder] 

o Type in: 

 chmod a+x droid.sh 

 chmod a+x droid-ui-6.1.3.jar 

 chmod a+x droid-command-line-6.1.3.jar 

 (If double clicking the jar files does not work with these three commands, 

try typing in chmod a+x *) 

 

 

To Use: 

- Open the driod-binary-6.1.3-bin folder. 

- Double click on the droid.bat file for Windows and droid-ui-6.1.3.jar for Mac OS. 

o Mac Users: If double clicking the droid-ui-6.1.3.jar file does not work and you 

have also typed in the chmod a+x *, you can also start it from the terminal. 

http://www.nationalarchives.gov.uk/information-management/our-services/dc-file-profiling-tool.htm
http://www.nationalarchives.gov.uk/information-management/our-services/dc-file-profiling-tool.htm
http://www.nationalarchives.gov.uk/information-management/our-services/dc-file-profiling-tool.htm
http://www.nationalarchives.gov.uk/information-management/our-services/dc-file-profiling-tool.htm
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 Open the Terminal 

 Navigate to the droid-binary-6.1.3-bin directory 

 Type in “./droid.sh” 

 

- Choose your settings 

o Under the Tools Menu, choose Preferences 

o If you want to calculate MD5 hash values, click the box 

 Note: This will take longer to run. 

o Adjust other settings as desired.   

 

- Add Folders/Files to Analyze 

o Add the folder you wish to identify by clicking the Add Button (Green Plus)   

o Navigate to the folder  

o Make sure the “Include Subfolder” box is checked  

o Click OK  

 

 

 

 
 

 

- Save the Profile  

o Click the Disk/Save button.  



 

 
DROID Resource Guide 

Created by CRKussmann; March 12, 2014   3 

o Name the profile  

o Save the file (to a location that you can find easily – i.e. desktop)  

 

- Run DROID 

o Click the blue Play/Start button 

o Wait for it to complete (status bar at the bottom) 

 

- Results 

- Results are displayed in table form on the screen  

 
 

- Results can be exported as .csv or xml 

o Export Results as .csv or .xml 

 Click the Export button  

 Select the profile to export  

 Select One Row Per File  

 Click Export Profiles  

 Save with appropriate file name and extension in appropriate location 

(e.g.: type .csv if you want to export as a comma delimited text file)  

 Click OK 

 

- Results can be used to create reports on certain properties  

o Create Reports 

 Various reports can be created under the Report Icon. For example, to 

create a report sorted by file extension, follow the steps below. 

 Click the Report Icon  

 Select the profile to run the report on  

 Select the File Count and Sizes by File Extension Report from the drop 

down list  

 Click Report on Profiles button  

 A report will be generated  
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 To save the report, click Export  

 Name the Report, Save to appropriate location  

 

- Re-Save Profile 

o If you would like to reuse the same profile again, remember to save it.  (You will 

be prompted to save it when you close the program.) 

 

 

 

 

Additional Resources for More Information 

 

- UK National Archives Documentation and video: 

http://www.nationalarchives.gov.uk/documents/information-management/droid-how-to-

use-it-and-interpret-results.pdf ; http://vimeo.com/24718678  

 

- Practical E-Records Blog Posts: Using DROID for Appraisal: http://e-

records.chrisprom.com/using-droid-for-appraisal/; http://e-records.chrisprom.com/more-

on-using-droid-for-appraisal/  

 

http://www.nationalarchives.gov.uk/documents/information-management/droid-how-to-use-it-and-interpret-results.pdf
http://www.nationalarchives.gov.uk/documents/information-management/droid-how-to-use-it-and-interpret-results.pdf
http://vimeo.com/24718678
http://e-records.chrisprom.com/using-droid-for-appraisal/
http://e-records.chrisprom.com/using-droid-for-appraisal/
http://e-records.chrisprom.com/more-on-using-droid-for-appraisal/
http://e-records.chrisprom.com/more-on-using-droid-for-appraisal/
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Exact File Resource Guide 

 
 

Tool Name:  Exact File 

 

Functionality/Use:  Create and verify checksum values for monitoring files over time.  

(Windows only) 

 

To Install:   

- Download at: http://www.exactfile.com/   (ExactFile-Setup.exe) 

- Double click file and select Run 

- Type in Admin User Name and Password 

- Work through Setup Wizard 

 

To Use: 

This program has multiple uses.  You are able to run checksums on single files, a group of files, 

or associate checksums with files copied to and from CDs/DVDs.  These instructions explain 

how to run checksums for a group of files.   

 

- Select the Create Digest Tab. 

 

 
 

http://www.exactfile.com/
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- Browse to the folder you want to run the checksums on  click OK 

 

- Choose if you will include subfolders, include full paths in output, and the name and 

location in which to output the checksum file.   

o Recommendations: Include subfolders; don’t include full paths; the output file 

will automatically be called “checksum” which works well, especially if you keep 

the file in the folder in which you are running the checksums. (Note: This is the 

default setting.) 

 

- Select from the dropdown the Method and Format of the checksum 

o MD5, SHA-1, SHA-256 are often used 

 
 

- Click Go   

 

- A report will be produced that provides information on when the checksums were run, 

the checksum value, and the file name.  Review if desired, and close it.  This file is saved 

as  in the location of your choice (folder you ran the checksums on). 
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To Verify Checksums 

 

- Navigate to the folder you want to verify checksums on 

 

- Double click the “checksum.md5” file  

o The file should open with ExactFile, but if not you can right click on the file and 

use “Open With”, and then navigate to Exact File.  (If you need to browse to 

Exact File, it might be in the Program File (x86) folder under Exact File.)   

 

- Once the file opens, it re-runs the checksum to see if any of the files have changed.  A 

report will appear that says “Every File OK” or explains the errors if there are any.   

 

 
 

 

 

Another guide with additional information can be found here: 

http://www.mnhs.org/preserve/records/legislativerecords/carol/docs_pdfs/ExactFileEvaluation.p

df 

 

 

 

http://www.mnhs.org/preserve/records/legislativerecords/carol/docs_pdfs/ExactFileEvaluation.pdf
http://www.mnhs.org/preserve/records/legislativerecords/carol/docs_pdfs/ExactFileEvaluation.pdf
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Hash My Files Resource Guide 

 

 
 

Tool Name:  Hash My Files 

 

Functionality/Use:  Create checksum value/s for monitoring files over time.  The program can 

calculate multiple checksums at the same time.  The program can also identify duplicate files.   

(Windows only) 

 

To Install:   

- Download at NirSoft: http://www.nirsoft.net/utils/hash_my_files.html  (the download 

link can be found 2/3 of the way down the page in light purple)  

- Unzip ‘hashmyfile.zip’  

 

To Use: 

- Open the hashmyfiles folder and double click HashMyFile.exe 

 

Selecting Hash Types and Other Options  

Before you run the program, you may want to take time and choose your settings.   

 

- Under Options, go to Hash Types, and select only the checksum algorithms you want to 

use.  You can only uncheck one box at a time; you will have to navigate to the menu for 

each one you want to select or remove. 

- To take advantage of identifying duplicate files, make sure the “Mark Identical Hashes” 

is checked.   

 

 
 

 

http://www.nirsoft.net/utils/hash_my_files.html
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Choosing Columns to View and for Reports  

 

- Under View, go to Choose Columns, then select the items you want to include on the 

screen as well as in a CSV report/file.  You can also order the columns here by 

highlighting the item you want to move and click the Move Up or Move Down buttons 

appropriately.   

 

 
 

- The resulting header bar might look like this: 

 

 
 

- After the settings are the way you want them to be you can select files on which to 

calculate hash values for.   

 

Calculate Hash Values 

 

[There are many ways to do this, only one way is shown below.]  

 

- Go to File, Add Folder 

- Browse to the folder you want to add 

- Select Add Files in Subfolders to capture any folder hierarchy 

- Click OK   
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The checksums will be calculated and information collected displayed.  One added benefit of this 

program is it visually demonstrates if duplicates are found by color coding and labeling the 

duplicate files.   

 

All headers can be used to sort the information.   

 

 
 

 

Save a Report 

 

- Sort the data and move the column order around if you choose. 

- [If you want to include headers in a csv file or tab delimited text file, you will need to 

click the box indicating your preference under Options.] 

- Highlight all of the records you want to include in the report (“Ctrl A” on your keyboard 

to select all items.) 

- To save click the Disk Icon or use the File menu and select Save Selected Items. 

- In the Save Window 

o Select the location you want to save the file in 

o Name the report 

o Choose a format 
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o Click Save 

 

A CSV report looks something like this:  

 

 
 

 

 

 

Another guide with additional information can be found here: 

http://www.mnhs.org/preserve/records/legislativerecords/carol/docs_pdfs/HashMyFilesEvaluatio

n.pdf 

 

 

http://www.mnhs.org/preserve/records/legislativerecords/carol/docs_pdfs/HashMyFilesEvaluation.pdf
http://www.mnhs.org/preserve/records/legislativerecords/carol/docs_pdfs/HashMyFilesEvaluation.pdf
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Tool Name:  Karen’s Directory Printer 

 

Functionality/Use: Document selected properties of files and folders within a selected directory.  

In addition to file/folder level metadata, the program can also be used to run checksums.    These 

properties could be used for documenting provenance, fixity, and capturing other information as 

necessary.  (Windows only)  

 

 

To Install: 

- Download from Karen’s Power Tools: 

http://www.karenware.com/powertools/ptdirprn.asp  

-  (ptdriprn-setup.exe) 

- Double click on the file 

- Type in Admin User Name and Password 

- Work through the Setup Wizard 

 

 

To Use:   

You can PRINT a report or SAVE a report.  You must choose/set the settings for each option.  

(You can always print a saved report.) 

- Open the program by double clicking on DirPrn.exe  

 

- Set Other Settings 

o Click the Other Settings tab 

o Select which File and Folder Information you would like to collect when you 

print or save a report 

o Choose your settings (and save them if desired by checking the box) 

 

- To PRINT 

o Set Search and Print Options  

 Select the folder / location you will run the program on. 

 Navigate to the folder that you would like to start the program in  

 Sort Files if desired (File Filter) 

 Set Print Options 

 Choose Search Sub-Folders for the most complete picture 

 Sort Files if desired.   

 Choose File Info and Folder Info 

 The lists pull options based on the items selected on the Other Settings tab.  

http://www.karenware.com/powertools/ptdirprn.asp
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 Use the arrows to order the information elements in the way you want to 

see them. 

 

o Click Print to print a report 

 

 

 

 
Screen Shot of Print Options (very similar to Save to Disk Options) 

 

 

- To SAVE TO DISK 

o Set Search and Save To Disk Options  

 Select the folder / location you will run the program on. 

 Navigate to the folder that you would like to start the program in  

 Sort Files if desired (File Filter) 

 Set Print Options 

 Choose Search Sub-Folders for the most complete picture 

 Sort Files if desired.   

 Choose File Info and Folder Info 
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 The lists pull options based on the items selected on the Other Settings tab.  

 Use the arrows to order the information elements in the way you want to 

see them. 

o Click Save to Disk 

o Save the report 

 Name the File, choose type (.txt, .tsv, .prn, or .dir), click Save.  

 

 

 

 

 
Screenshot of Save to Disk Report 

 

 

 

 

Additional Resources for More Information 

 

- University of Hull Idiot Guide No. 4: Karen’s Directory Printer: 

http://www.hullhistorycentre.org.uk/discover/pdf/Idiots%20Guide%204%20-

%20Karens%20Directory%20Printer.pdf  

 

- Minnesota State Archives User Guide: 

http://www.mnhs.org/preserve/records/docs_pdfs/KarensDirectoryPrinter.pdf  

 

 

http://www.hullhistorycentre.org.uk/discover/pdf/Idiots%20Guide%204%20-%20Karens%20Directory%20Printer.pdf
http://www.hullhistorycentre.org.uk/discover/pdf/Idiots%20Guide%204%20-%20Karens%20Directory%20Printer.pdf
http://www.mnhs.org/preserve/records/docs_pdfs/KarensDirectoryPrinter.pdf
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Tool Name: Metadata Quality Control (MDQC) 

 

Functionality/Use:  Compare metadata fields, for verifying technical and administrative 

specifications of files.  Tool is useful for performing quality control tasks.  (Windows and Mac) 

 

To Install:   

- Download from AudioVisual Preservation Solutions: 

http://www.avpreserve.com/avpsresources/tools/  (mdqc-win.zip or mdqc-osx.zip)  

- Unzip folders (if necessary). 

 

To Use:  (Windows based instructions) 

- Open the mdqc-win or mdqc-osx folder 

- Double click on the MDQC.exe or MDQC.app file 

 

 
Main Screen 

 

- Point to a Reference File 

The metadata fields in the reference file will be used to compare the files in the chosen 

directory.  Make sure this file has the correct information in the fields of concern.   

o Use the browse button (…) to find the reference file 

 

- Select which tool you would like to use to pull metadata out of the files: ExifTool or 

MediaInfo (Click on the Tools menu.) MediaInfo only pulls metadata from audio and 

video files and ExifTool can pull metadata from a variety of other file formats.  View a 

list of ExifTool supported formats: 

http://www.sno.phy.queensu.ca/~phil/exiftool/#supported 

 

 

 

 

http://www.avpreserve.com/avpsresources/tools/
http://www.sno.phy.queensu.ca/~phil/exiftool/#supported
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- Set the Metadata Rules   

If this does not work on the Mac, see the troubleshooting guide below.  

o Readable metadata fields are pulled out of the reference file and populate a grid. 

o Use the dropdown menu to select how important the field is and what you want 

the metadata in that field to do:  

 
Drop Down Menu for Metadata Rules 

 

o When you are done making your selections click the Set Rules button at the top of 

the screen. 

 
 

- Point to a Directory to Scan 

o Use the browse button (…) to point to the directory that contains the files you 

want to compare metadata fields with the reference file’s metadata fields.  

 

- Set the Scan Rules 

o If you would like to include or exclude files or directories based on what their 

names contain or do not contain, set these rules.   

 

- Click Begin Test 

 

- A window appears that tells you how many files it found. 

 

- All files are compared to the reference file and an output displays if the file passed or 

failed and why.   (see screenshot below) 
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On Screen Results 

 

- A report documenting the results is created and saved as a .csv file in the program folder 

(mdqc-win folder).   

 

- Information on how to use the .csv file is found in the MDQC User Guide below.   

 

 

Additional Resources for More Information 

 

- Official MDQC User Guide: http://www.avpreserve.com/wp-

content/uploads/2013/10/MDQCUserGuide.pdf 

 

 

http://www.avpreserve.com/wp-content/uploads/2013/10/MDQCUserGuide.pdf
http://www.avpreserve.com/wp-content/uploads/2013/10/MDQCUserGuide.pdf
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Trouble Shooting: 

 

Mac:  

 

If you can open MDQC but the Metadata Rules button is not pulling up any information, you 

might need to install both the ExifTool and MediaInfo.   

- ExifTool for OSX: http://www.sno.phy.queensu.ca/~phil/exiftool/ExifTool-9.47.dmg 

- MediaInfo for OSX: 

http://mediaarea.net/download/binary/mediainfo/0.7.66/MediaInfo_CLI_0.7.66_Mac.dm

g 

 

 

 

http://www.sno.phy.queensu.ca/~phil/exiftool/ExifTool-9.47.dmg
http://mediaarea.net/download/binary/mediainfo/0.7.66/MediaInfo_CLI_0.7.66_Mac.dmg
http://mediaarea.net/download/binary/mediainfo/0.7.66/MediaInfo_CLI_0.7.66_Mac.dmg
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Tool Name:  Duplicate File Finder 

 

Functionality/Use:  Find duplicate files in a selected group of files; you can also choose to 

immediately delete the files as well.  [The free version allows you to find and delete files, but 

additional features are available in the Pro (paid) Version.]  (Windows only) 

 

To Install:   

- Download from Ashisoft at: http://www.ashisoft.com/   (dfsetup.exe) 

- Double click file (dfsetup.exe) and select Run 

- Type in Admin User Name and Password 

- Walk through Setup Wizard 

 

 

To Use: 

- Double click on program Icon  

- Choose the area/s that you want to search for duplicate files (Add Path) 

- Choose the method in which to find duplicate files (“Content Match Byte by Byte” is 

most thorough)  

- Click Start Search 

 

 

http://www.ashisoft.com/


 

 

 
Duplicate File Finder Resource Guide 

Created by CRKussmann; March 12, 2014   2 

- Results will be returned 

 

 
 

- Verify files to be deleted (if you want to delete a different file, just check/uncheck the 

boxes next to the file name).  Files with the checkmark will be deleted.   

 

- Delete Duplicates (send to recycle bin or delete immediately)  

 

 
 

 

Additional Resources for More Information 

 

- Online Tutorial from Company: http://www.ashisoft.com/find-duplicates-step-by-

step.htm  

 

- Guide: http://www.mnhs.org/preserve/records/docs_pdfs/DuplicateFileFinder.pdf  

http://www.ashisoft.com/find-duplicates-step-by-step.htm
http://www.ashisoft.com/find-duplicates-step-by-step.htm
http://www.mnhs.org/preserve/records/docs_pdfs/DuplicateFileFinder.pdf
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Windows Directory Statistics (WinDirStat) Resource Guide 
 

 

 

Tool Name:  Windows Directory Statistics 

 

Functionality/Use: “WinDirStat is a disk usage statistics viewer and cleanup tool.” It helps 

visualize the contents of selected drives, learn more about the properties of selected content, and 

allows you to delete content.  (Windows only.  See WinDirStat site for Mac OS program 

suggestions.)  

 

To Install: 

- Download from WinDirStat: http://windirstat.info/index.html  

(windirstat1_1_2_setup.exe) 

- Double click on the file 

- Type in Admin User Name and Password 

- Work through the Setup Wizard 

 

 

To Use:   

- Double click on the program icon 

- Choose All Local Drives or Individual Drives 

- Click OK 

 

 
Figure 1: Select Drives 

http://windirstat.info/index.html
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- The program will run.  You will see Pacman as the status bar.   

 

- After the drives have been mapped, you will see three areas on the results window. 

o Directory List (top window similar to windows folder structure, organized by 

size) 

o Extension List (right hand window listing file extensions and color legend for the 

tree map) 

o Treemap (the colored section at the bottom) 

 

 
Figure 2: Results Display (Directory List, Extension List, Treemap) 
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- Use the Directory List to show where a particular set of files can be found and how much 

space it takes up. 

 

 
Figure 3: The white highlighted box is my Desktop.   

File properties are given in the Directory View. 
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- Additional file properties can be seen by using the drop down under  

Clean UpProperties  

 

 
Figure 4: Windows File Property Screen 

 

- Use the Extension List to see the file types you have and visualize them.   

 

 
Figure 5: This image shows the .zip files I have (green with the white box around them) 
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- Use the Treemap to visualize your content.   

 

 
Figure 6: Color coded “Tree Map” that helps you visualize what types of files you have. 

 

- You can also show free space, (Options  Show Free Space) 

 

- You can email reports to users (Using Outlook Profiles?) [Did not try this.] 

 

- You can delete files from the program. 

 

o Clean Up  Delete (to Recycle Bin) 

o Clean Up  Delete (no way to undelete) 

 

- Using other dropdown choices you can: 

o Open the file location. 

o Copy the file path. 

o Open the command line at the desired location. 

 

 

Additional Resources for More Information 

 

- WinDirStat Website  

http://windirstat.info/index.html   

 

http://windirstat.info/index.html

